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Chapter1  ANC5150 Numerical Control Laser System 

1.1 Introduction of ANC5150 

The structure of ANC5150 Numerical Control Laser System is showed as Figure 1-1: 
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Figure 1-1 Structure of ANC5150 

 
ANC5150 Numerical Control Laser System uses technology of high-speed motion control DSP, embedded DSP 

real-time operating system, embedded 10/100M self-adapting industry Ethernet and fieldbus. DSP, namely, Digital 
Signal Processsor, is a special microprocessor used to process real-time signals, transfer and control. DSP realizes 
sorts of complicated numerical control arithmetic quickly and real time. Embedded 10/100M self-adapting industry 
Ethernet supports high-speed and reliable communication broad band between computer and laser control system. 
Fieldbus affords steady and reliable communication link for system expansion and distant control. The distance of 
Ethernet and fieldbus communication can reach 40m. If use HUB, Ethernet can transfer farther. Because of Ethernet, 
it is possible for the system to remote update and remote control. 

1.2 System Components 

As Figure1-1, ANC5150 numerical control laser system softwares are constituted by AgeMotion6 and assistant 
softwares. The hardwares consist ANC5150 controller, ANP4149 portable panel, stepping motor drivers and a few 
lines. 

1.3 System Features 

ANC5150 system uses high-speed motion control DSP, embedded DSP real-time operating system. This system 
can remote diagnosis and remote update for using network communcation. Embedded 10/100M self-adapting 
industry Ethernet provides maximal 100Mbps communication broad band for the system. The main features of 
ANC5150 is as follows: 
1. Speeds of Sculpturing and cutting up to 60m/min both 
2. High resolution up to 13600DPI, resolution reaches 0.002mm 
3. Precision of repeated orientation/poweroff restart up to 0.01mm 
4. Genuine stepless speed variation, 0~60m/min 
5. High fieldbus AFB1, distance of communication 40m 
6. Embedded 10/100M self-adapting industry Ethernet.It supports surfing on net or running other programs during 

system working and will not destroy machining technics. It supports multimachine control (AgeMotion6 supports 
limitless machines. General accreditation supports 3 machines and special accreditation supports limitless 
machines). 

7. Power off protection 
8. There are protection circuits for inputs of sensors and dc power supply, avoiding short current, inverted connect 

and interfere. 
9. Reliability design for avoiding system halt and restart 
10. Memory function on mechanical and software 
11. ANP4149 supports individual control function 
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12. Supports gradient Sculpturing 
13. Supports high-speed cutting and adjusts cutting precision automatically 
14. Supports return difference compensate and unilateral Sculpturing 
15. Supports photoengraving 
16. Supports setting freewheeling and working parameters individually 
17. Supports two levels batched processing, two levels multitask and two levels array setting. It is suitable to factory 

batch production. Sculpturing, cutting, outline and so on can be combined freely and parameters of every task 
can be setted individually. 

18. Supports optimization arithmetic such as grads and path optimization 
19. 12V1A/5V4A dc power supply 
20. Supplys test software of manufacture* 
21. Supports printer output* 
22. The contoller has the function of antivirus and defending hackers  
23. Supports search and set controller automatically* 
24. Low power dissipation, minimal dissipation is 2.5W 
25. Supports file formats more than ten such as BMP, PLT and DXF. 
 
Note: 
*: The function can be updated. This function can update by remote softwar. The other marks * in this manual 
followed is same. 
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Chapter2  AgeMotion for Numerical Control Laser System 

Edition introduction: lastest edition V6.01.77 

2.1 Introduction 

The series of AgeMotion6 software, as an important part of ANC5150 system, is used in motion control mostly. 
It controls the Numerical control electrical machinery by computer, completes the different task according to different 
commands. There are some properties of AgeMotion6 software as follow shows: 
1. Deal with many kinds of graph files; the supporting documentation types include PLT, BMP, DXF, DST, JPG, 

ICO, GIF and so on. The PLT file is generated from CorelDRAW, the BMP file could be generated from 
Photoshop, the DXF file could be generated from AutoCAD. Please check all of the file introductions in 
appendix A. 

2. Open many graph files at the same time, translate graphs, zoom in/out graphs, rotate graphs, preview, test, 
sculpture and cut. This software can be simulated as a keyboard to control the Sculpturing system. 

3. Implement edition, transformation, effect of graphs, control the movement object according to the setting of 
groaph and movement (Must unify the hardware control system). 

4. The series of AgeMotion6 software supports multi-machine control, in order to economize the cost and power 
loss of system. It realizes the high-speed, credible and steady motion control combining with DSP high-speed 
control system. 

5. The series of AgeMotion6 software’s communication with machines is base on ethernet network, so it can 
implement remote control to machines (Please look over the introduction of ethernet network in the first section 
of chapter 11). 

6. Combine files. The series of AgeMotion6 software can use several PLT files and DXF files which are vector files 
to form a synthesis, output a synthesize file that mixed several graphs of different files together, the final vector 
file mixed must be saved as a DXF file, so that meeting the needs of processing in the future, improving the 
efficiency more and more in this way. 

7. The software imports English Interface. 
8. The software sets authorization password. If no password of the password error or exceeded the software can not 

use normally and can not connect with machine exactly. 

2.2 Environment 

1. CPU should be more advanced than 586, suggest use PIII, PIV or a better one. 
2. Memory should be larger than 256 M. 
1. Make sure having installed the ethernet network (10/100Mbps self-adapt). 
2. Windows98/2000(SP4)/XP. 

Microsoft had provided the service-package for Windows98 no longer , it also will stop to provide the 
service-package for Windows2000 after providing the last service-package in the near future , so please use this 
software under WindowsXP(SP2). 

2.3 Install and Startup 

2.3.1 Install 
1. Insert the CD, the operating system will run the setup.exe automatically; finish installation quickly according to 

the guide of the process. 
2. If it didn’t install automatically, run the setup.exe on the CD, and install according to the guide of process. When 

install the software, the user input the software serial or use the default. The software serial decide the type of 
software. Differtent type of software function is different also. The main differences along the types are control 
of task property. The defalult installation type is no authority as a dome-usage.  

3. Set the ethernet network after the software installation. Please set the TCP/IP Address as this style: 10.10.10.XX, 
the XX must be a number between 2 to 254, the code of Subnet Mask should be 255.255.255.0, press OK and 
exit. Then finish the setting. Windows2000/XP should not restart, but Windows98 need. 
Where to set: 
XP operating system: network neighborhood  property  local link  property  Internet protocol 
(TCP/IP)  property 
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Detail settings show as Figure 2-1. 
 

 
Figure 2-1 TCP/IP Setting 

 
Connect computer with machine by the reticle markered AB, and connect computer or machine with HUB by 

the reticle markered BB. Through the reticle markered AB to connect the UPLINK port of HUB. Ususlly, HBU has 
only one UPLINK port, so UPLINK port and the other port near the UPLINK couldn’t be used together in the same 
time. Connect Machine with panel controller by the reticle markered BB. 
B end: 1: white /yellow 2: yellow 3: white /green 4: blue 5: white /blue 6: green 7: white /brown 8: brown 
A end: 1: white /green 2: green 3: white /yellow 4: blue 5: white /blue 6: yellow 7: white /brown 8: brown 
The reticle markered A-B means one end of the reticle is made in the way of A end, the other end is maked in way of 
B end. 
The reticle markered B-B means both of two end is made in the way of B end. 

2.3.2 Startup 

1. Open the start menu of operating system, according to the path (AutomaticAge   AgeMotion6   
AgeMotion6) to find the programme in the programme menu, run the program. 

2. Run the programme by the AgeMotion6 shortcut on the desktop immediately. 

2.4 Frame of AgeMotion 

2.4.1 Main Interface 

The first appearance of AgeMotion6 software when you run the program likes the Figure 2-2 shows. 
The main appearance is made up of menu bar, toolbar, status bar and view. Tiltle bar which is on the top of the 

window shows the file name and the path opened. Its color expresses the file is activated or not. There is a control 
menu icon on the left of title bar, press the icon, a control menu which used to change the size and position of the 
window will be opened, includes revert, move, exit, maximize and minimize. From left to right, there are buttons for 
minimization, revert and exit on the right of title bar. 

Menu bar and Tool bar are under the Title bar, move mouse to the buttons on Tool bar and pause for one second, 
the hint of the button will pop in Status bar. A viewport where the graphs will be shown all right is under the tool bar. 
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The Status bar is on the bottom of the window, hints of your operation or your command now will be shown here. 
 

 
Figure 2-2 Main Window of AgeMotion 

 
The interface after opening a file likes the Figure 2-3 shows. There will be a ruler in the margin of the viewport, 

some assistant lines in the view, to hide the ruler and assistant lines, please cancel these two choices on the Tool bar. 
Maybe there will be an edit dialog box, information dialog box, layer dialog box and machine manage dialog box in 
the window area. 

To maximize, minimize and move the graph in the view, please press the button for maximize, minimize and 
move , if the mouse used has three keys, also can maximize and minimize graphs by the middle key. 

 
Figure 2-3 Open a File 
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2.4.2 Menu Bar 
The software menus contain the begin menu before opening a file (see Figure 2-4) and the second menu after 

opening a file (see Figure 2-5). 
 

 
Figure 2-4 Begin menu 

 
The begin menu is the menu when didn’t open any file, adjust some simple setting of the window to meet 

requires. Otherwise, adjust these settings after opening a file; these two ways bring the same effect. Choose the file 
which to be opened in the file open dialog after choose the option (File   Open), or open the file opened recently 
as well as, the file menu shows 16 files that you opened recently. Otherwise, double clicking the left mouse button in 
the view also can open the file open dialog if haven’t any file opened. 

 
Figure 2-5 Second Menu 

The second menu is loaded after open a file, then do more particular operations to the graph. 

Openning the file which will be processed through the File menu, or click the button . The software supports 
many formats file, such as PLT, DXF, BMP, JPG, DST and so on. The BMP file could be sculptured and cut the 
outline border only, can’t be cut the graph. 

Save the file by the (File   Save As) menu. Because processing graghs is on a base of layers, the most 
particular property is combining several graph files to one graph file (notice: it only can combine several PLT files, 
several DXF files or several PLT files and DXF files to a DXF files), likes the Figure 2-6 shows. First, open a graph 
file that you want to be combined, second, import the other files (see Figure 2-7) to be combined, then the files are 
combined to be one file. Finally, save the file combined as a DXF file, the different graphs are distinguished by layers 
in this file. On this way, users need to open one file instead of several file to process, so that to operate easily. 

 

 
Figure 2-6 Import a Graph File 
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Figure 2-7 File Combined 

 
Choose options in the View menu to adjust the view and change the view styles, such as aid lines, mark lines, 

rulers, edge and so on (see Figure 2-8). 

 
Figure 2-8 View Menu 

 
There is a Toolbar, a sub menu, in the View menu (Figure 2-9), decide to show or hide the edition box, file 

information box and machine management box in this sub menu (Figure 2-10). 
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Figure 2-9 View-Tool 
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Figure 2-10 Information Box 

 
The position of the mouse in time, the color of the current point, and the unit of the graph are shown in the 

information dialog box, the looked down graph is also shown in the view of the information dialog box. The file 
information dialog box contains four pages, they are layer, object, channel and page layout, edit the layers of the 
graph in the layer page. The machine property page shows the management, control, mission and log informations 
about current machine. 

Change the scale of the graph exactly and quickly in the menu (View   Zoom), likes the Figure 2-11 shows. 
 

 
Figure 2-11 View-Scale 

 
To adjust the coordinate by Coordinate option in the Image menu (see Figure 2-12), from the first to the fourth 

option change the effect of seeing only, didn’t effect on the operation. From the fifth to the twelveth option change 
the origin of the machine’s coordinate system, they effect on the operation. 
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Figure 2-12 Adjust Coordinate 

 
To switch the unit of graph by Unit option in the Image menu (see Figure 2-13), if switched the unit ,the hints 

shown in the information dialog box is also changed. 
 

 
Figure 2-13 Unit Switch 

 
Choose the Layer manage option in the Layer menu, a layer manage dialog box will appear (see Figure 2-15). In 

this box, can set layer show or hide, change the color of the layer, the line style and width of the layer. 
 

 
Figure 2-14 Layer Menu 

 



AgeMotion Datasheet 
 

Hangzhou AutomaticAge Co., Ltd.  Http://www.AgeMotion.com/ 11

 
Figure 2-15 Layer Manage 

This dialog box above contains all informations of the layer, to chang the layer setting in this box. 
 
Through the Window menu to change the window style (see Figure 2-16), in particular, change all the sub 

windows to a friend style when opening a lot of files at the same time. 
 

 
Figure 2-16 Window Menu 

 
Please choose the Machine sub menu to manage the machine (see Figure 2-17), the operations have add a new 

machine, set the machine’s parameters, start machine, begin to process and check the log. 
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Figure 2-17 Machine Menu 

 
Draw menu provide some types of graph to drawing, such as trail, polyline, polygon,rectangle, circle and so on. 

Align is to align the graphs selected by one form. Fill is to fill the graph selected by backlight line(the detail refer to 
chapter6). 

 
Figure 2-18 Draw Menu 

 
In the Help menu, there is some information about this software and two language choices, one is English, the 

other one is Chinese Simplified, the hints will shows in which language selected. If you want to change the language, 
you should select the language and close the software. Then open the software again. Thus the language changes 
succeed. 
 

 
Figure 2-19 Help Menu 
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2.4.3 Tool Bar 

 
 

A majority of menu control options have the parallel button on the Tool bar, move the mouse over the button for 
a pause, a hint about this button will pop, the information about this button’s fuction will also be shown in the Status 
bar, so that operation become easy. 

2.5 Machine Manage 

2.5.1 Add Machine 
Click the AgeMotion6 shortcut to run the programme. 
Choose the Machine Manage option in the Machine menu, a machine manage dialog box will be opened. On the 

Tool bar, click the Machine Manage button: , Control Panel button: , Task Manage button:  or Log button: 

, also can open the machine manage dialog box (see Figure 2-20). 

 
Figure 2-20 Manage Dialog 

 

Adding machine and setting parameters: 

1. Choose the Machine Manage property page, and click the mouse right button to add a new machine. 
2. Choose a machine to set the parameters about this machine, machine name is symbol of this machine, it can be 

any letters. Machine type is ANC5150, enter the address, serial number and port number, and get them from 
provider. 
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3. Get the password from the provider and input it. Lack of password or the password is out of date, the software 
will not conncent with machine exactly. 

4. Auto link property*: if this check box is checked, the software will connect with machine automatically in the 
next start time or when the hardware reposition (This fuction is on test, can’t be used now). 

5. Origin: Set which dot as the coordinate origin. You can choose Left Top, Right Top, Left Bottom or Right 
Bottom.Choose the different origin the task pretreat mode will different. The effect of this action will take the 
show the same as display on layer as working. 

6. Task Pretreat: Pretreat the task display mode. You can choose Flip Vertical, Flip Horizontal and Vertical, Flip 
Horizontal or No Treatment. 

7. Setting X coordinate and Y coordinate length: these values mean the longest distance that machine can move on 
the X coordinate and Y coordinate. Set the parameters custom or adopt the default values. 

8. X Step and Y Step: X coordinate step distance and Y coordinate step distance. These values mean the distance 
that machine move for one step in fact, they are defined on base of the practical condition. Get these values 
through adjusting if having no idea of the machine’s step distance exactly. How to set the machine’s step distance, 
please see the machine’s step distance setting paragraph. 

9. Pad velocity and Pad acceleration. 
10. ConnectTo: display the absolute path of currenet file. 

2.5.2 Machine’s Step Distance Setting 

1. Input values near the right values in the X coordinate step distance and Y coordinate step distance edit box, as 
X1, Y1 (for example 0.2, 0.2), click the second button  on the bottom of the management dialog box to link 
the machine (Make sure the electrical source is turned on). The other way, click OK and cancel the dialog, press 
the link button  on the Tool bar or select the Connect option in the Machine menu to link the machine, when 
connecting with the machine, the Status bar will show the current state.  
If the software can’t connect with machine, and the password is not out of date, please make sure the computer 
is link with the network, run the command ping 10.10.10.xx –t to check the computer is linked to the network, if 
the machine’s address is 10.10.10.105, please input 10.10.10.105 –t, click OK and run, keep to ping for one 
minute, succeed as long as one time （ window shows one or more times as 

）means the network is no problem. 
When the computer ping the machine, the ANC5150 Ethernet LED TX/RX is bright. If the TX/RX LED isn’t 
light, the network link is fail, the cause is one among these: the reticle is broken, A/B reticle is wrong, machine 
stopped because of failure (It can work in gear after reposition), the wrong setting of the network. 

2. Open the “square100.plt” file from “\Program\AutomaticAge\AgeMotion6\Examples” (The path of this 
software installed), click mouse right button in the view and select the option “current layer to current machine” 
in the pop menu to add the current layer to missions (Have to do this work before processing). 

 The layer had added is list in the combo box, choose the layer to process form 
this combo box. Likes the Figure 2-21 shows: 
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Figure 2-21 Add Task 

 
3. There will be a machine-mission property (See Figure 2-22) pop after adding a layer to missions. Input 0 in the 

left and top edit boxes (or choose Pos. Mode as”Zero”) and select them in the first piece area, width and hight is 
the size of processing, register as (A, B). Other values are default. 
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Figure 2-22 Task Dialog 

 
4. Choose the control property page (see Figure 2-23), computer is link with the machine, so the Mot. button is 

activated, click the direction buttons to test the machine first. Cancel the selection of the absoluteness, click the 
direction buttons, machine will move in the direction clicked, its distance moved ervery times is according to the 
parameters: X coordinate step distance and Y coordinate step distance (Step distance means the distance the 
machine moved when click the button one time). Select the absoluteness, the machine will ignore the X 
coordinate step distance and Y coordinate step distance, it moves on base of the swing in the management 
property page, click the right-bottom button, the machine will move to the right-bottom of the hole area it can 
move. Input values in the X coordinate setting and Y coordinate setting, and click the Set button, then the 
machime will go to the position appointed. If the X coordinate offline and Y coordinate offline is pressed, the 
machine is out of software’s control in both directions when moving. In the laser control setting area, the laser 
control parameters set previously in mission property page is shown, Input values and click the set laser button, 
the values will be changed. Click the laser out button, the laser will output. 

5. Press the buttons: water pump, air refresh, gas pump, laser power and laser hight voltage, click the fifth button 
 on the dialog’s left-bottom to start the processing. 
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Figure 2-23 Control Dialog 

 
6. After finishing the process, measure the rectangle’s width and height, register as a and b (a, b), if (A, B) is not 

equal to (a, b), according to these formulas as follow to compute the machine’s real X coordinate and Y 
coordinate step distance: X2 = (X1 × a) / A, Y2 = (Y1 × b) / B. 

7. Open the management property page, input the result X2 and Y2 in the X coordinate step distance and Y 
coordinate step distance edit box. Open the control property page (see Figure 2-23), click Hard Rst button to 
reposition the hardware, the machine is out of line now, and the control property page shows as Figure 2-24, all 
of the buttona except power are not activated, then click the second button  to connect the computer to the 
machine, activate the buttons as step 5. 

8. Return the mission property page, cancel the selection of width, height and width-height scale, set the width 700, 
set the height 400, register them as A = 700, B = 400. Click the fifth button  on the dialog’s left-bottom to 
start the processing. 

9. After finishing the process, measure the rectangle’s width and height, register as a and b (a, b), if (A, B) is not 
equal to (a, b), according to these formulas as follow to compute the machine’s real X coordinate and Y 
coordinate step distance: X3 = (X2 × a) / A, Y3 = (Y2 × b) / B. 

10. Open the management property page, input the result X3 and Y3 in the X coordinate step distance and Y 
coordinate step distance edit box. Open the control property page (see Figure 2-23), click Hard Rst button to 
reposition the hardware, the machine is out of line now, all of the buttona except power are not activated, then 
click the second button  to connect the computer to the machine, activate the buttons as step 5. 

11. Return the mission property page, cancel the selection of width, height and width-height scale, set the width 780, 
set the height 460, register them as A = 780, B = 460. Click the fifth button  on the dialog’s left-bottom to 
start the processing. 

12. After finishing the process, measure the rectangle’s width and height, register as a and b (a, b), if (A, B) is not 
equal to (a, b), according to these formulas as follow to compute the machine’s real X coordinate and Y 
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coordinate step distance: X4 = (X3 × a) / A, Y4 = (Y3 × b) / B. 
13. Then the result X4 and Y4 are near the exact values, input the result X4 and Y4 in the X coordinate step distance 

and Y coordinate step distance edit box. 
 

 
Figure 2-24 Control Dialog 2 

 
Notice: The parameters about machine’s step distance should be set only one times when adding a new machine, 

needn’t to set again except add another new machine. 

2.6 Task Manage 

Select the Task manage option in Machine menu, or the button  in the Tool bar, a mission – manage dialog 
box will pop, likes the Figure 2-25 shows. When add a new mission, this dialog pop also. 
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Figure 2-25 Task Dialog 

 
In the mission list, list all the missions of current machine, the work start from the top mission to the bottom 

mission in turn. The task can be deleted.Choose the layer and click mouse right button, likes the Figure 2-26 shows. 
Click Delete, then the task is deleted. 

 

 
Figure 2-26 Delete Task 

2.6.1 Select Task 

To set the parameters of one mission, make sure the mission is selected, select the mission in the left mission list, 
then all the parameters shown are about the current mission. Likes the Figure 2-25 shows. 

2.6.2 Set First Task Area 
Set workpiece position and size. 
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Figure 2-27 Set First Task Area 1 

 
Left, right, top, bottom is the processing area, left and top is the start position, right, bottom is generate by the 

width and height. 
Width and height is the work area size, set them by youself, the default values are the layer’s real size. 
Adopt the default X and Y coordinate scale, default value is 1, like the Figure 2-27. 
The user-defined scale shows as Figure 2-28. 
Pos. Mode include Zero, User define, Laser position and absolute. Zero: coordinate zero，default the lefttop is 

coordinate zero. So Left and Top are all 0. Of course, you can adjust the zero as leftbottom, righttop and rightbottom 
also. User define: user define the position of graph. Laser position: the laser current position as the position of graph. 
Absolute: the position of graph in the layer. The user can adjust mode need. 

 

 
Figure 2-28 Set First Task Area 2 

2.6.3 Set Task 

 

 
Figure 2-29 Set Task 1 

 
Name: layer name, can be any letter. 
Valid: judge the mission is available or not. When the mission is invalid, machine will ignore this mission. 
Wait: Wait time before task begin, see Figure 2-30. The unit is second. 
Total: the count shoud be processed. 
Page Sure: If check this option, a affirm dialog box will pop before processing, must click the continue button to 

go on (see Figure 2-31), if this option is not checked, the machine will perform the programme automatically without 
the affirm dialog box. 

 

 
Figure 2-30 Set Task 2 
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Figure 2-31 Task Sure 

 
One Sure: in the array working, a mission contains several piece, if check this option, affirm by yourself to 

continue the work after one piece is finished. If don’t check the option, the system will finish all the missions 
automatically without affirm dialog. 

X Array: the count in X coordinate direction. 
Y Array: the count in Y coordinate direction. 
X Offset: space between two piece in X coordinate direction (contain the workpiece width). 
Y Offset: space between two piece in Y coordinate direction (contain the workpiece height). 

2.6.4 Set Task Group 

 

 
Figure 2-32 Set Task Team 

 
Name: shows the current machine’s name. 
Valid: judge the mission is available or not. When the mission is invalid, machine will ignore this mission. 
Wait: Wait time before task group begin. 
Total: the count shoud be processed. 
Page Sure: If check this option, a affirm dialog box will pop before processing, must click the continue button to 

go on, if this option is not checked, the machine will perform the programme automatically without the affirm dialog. 
One Sure: in the array working, a mission contains several piece, if check this option, affirm by yourself to 

continue the work after one piece is finished. If don’t check the option, the system will finish all the missions 
automatically without affirm dialog. 

X Array: the mission group count in X coordinate direction. 
Y Array: the mission group count in Y coordinate direction. 
X Offset: space between two missions group in X coordinate direction. 
Y Offset: space between two missions group in Y coordinate direction. 

2.6.5 Set Parameters 

Please set all the parameters according to the real condition in mission-manage property dialog. 
Work V: the laser head’s speed when it work normally, unit is mm/s or Inch/s, change it in the Image menu, the 

max speed is 1000mm/s. 
Work A: it is the differential coefficient of the working speed, it decide the time when machine from start to the 

speed set previous, its unit is mm/s2 or Inch/s2, the max acceleration is 5000m/s2. 
Spare V: it is the speed when working but the laser is not out, its unit is mm/s or Inch/s, the max value is 

1000mm/s. 
Spare A: it is the differential coefficient of the Leisure speed, its unit is mm/s2 or Inch/s2, the max acceleration is 
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5000m/s2. 
Current: precent of laser current, a number between 0 and 100. 
Intensity: the intensity of the laser, is a number between 0 and 100000. 
Scan Buf +: increase the extra scanning cushion width when Sculpturing. 
Scan Step: the distance between two lines when doing the line scan, the range is 0.001-500mm, the default 

value is 0.1mm. 
Clr.Comp.: through the compensation, it can clear up the margin sawtooth caused by the strap’s interspace, but 

the machine will not add the extra distance, so it don’t affect the working time. The value can be adjusted from –1mm 
to 1mm, it doesn’t compensate when this value is 0 or it scan in one direction. This value is set to be 0 or greater than 
0, the type value is 0.2mm. 

Positive: this option is effective when the working mode is Sculpturing, it is negative Sculpturing when this 
option isn’t checked. 

Unid. Scan: it means the laser is output in a direction only when working, it can clear up the margin sawtooth 
caused by the strap’s interspace in this way, so that it will improve the product’s quality. It Scan in both direction 
when it isn’t checked. 

Work mode: there are cut, cut the frame, cut and cut the frame, sculpture and sculpture the slope in the combo 
box, every mode is effective to all the vector graphs. Cutting is effective to vector graph only, it can’t cut the bitmap. 
Cut mode cut the graph only, cut the frame mode cut the rectangle that contain the graph only, cut and frame mode 
cut the graph first, then cut the frame, we can distinguish the parts easily in this way. 

2.6.6 Set Optimize 

According to the user-defined optimal parameters, machine will move in a optimal path, in order to enhance the 
efficiency, so it is very useful when cutting but useless when Sculpturing. 

Optimization contains optimize in gradient and optimize in path, both of them can be checked at the same time 
(see Figure 2-33): 
 

 
Figure 2-33 Set Task Optimize 

 
1. Optimize in Gradient: must choose this optimization when cutting through the material. If this option is chosen, 

the machine will cut the inside graph first, then cut the outside. In this way, machine cut every part integrallty in 
turns. For example, when cutting a traffic circle, if choose this optimization, machine will cut the circle inside 
first, and then cut the cirle outside. Machine will take some time to computer when choose this optimization. 

2. Optimize in Route: route optimization contains four grades: primary optimization, intermediate optimization, 
senior optimization and holistic optimization, choose the primary optimization. Optimization includes X 
coordinate optimization and Y coordinate optimization, the parameters could be user-defined, or defined by 
software. Click the X coordinate first button, the parameters will be 1 and 0, then machine will move in X 
direction first. Click the Y coordinate first button, the parameters will be 0 and 1, then machine will move in Y 
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direction first. Click the equilibria button, the parameters will be 0.5 and 0.5, then the path is optimal. Table 2-1 
is a group testing values about different optimizations, as it shows, choose the balanced optimization is best. 

 
   Testing parameters 

Files 
 

Path 
 

Scale 
 

Efficiency 

“再别康桥” Primary optimization 0.5: 0.5 3’20” 

“再别康桥” Primary optimization 0: 1 3’22” 

“再别康桥” Primary optimization 1: 0 3’30” 

“百家姓” None None 44’15” 

“百家姓” Primary optimization 0.5: 0.5 39’45” 

“百家姓” Primary optimization 0: 1 67’47” 

“百家姓” Primary optimization 0.3: 0.7 40’15” 

Table 2-1 Optimize Test 
 

2.6.7 Set Slope 
Slope: click Grd. button to set the slope parameters when sculpturing the slope, the slope manage dialog box 

likes Figure 2-34 shows: 
 

 
Figure 2-34 Set Slope 

 
Left list shows the information about all the ranks, contains the number and depth of the ranks. The number is 

from 0 to a number defined, depth is the number that Sculpturing can reach. It can be modified on the right to one 
rank. 

Steps: the series of sculpturing the slope, is a number between 3 and 30, it is one greater than the largest rank ID. 
Width: the width of every ranks, there are four choice in the combo box: 0.025mm, 0.05mm, 0.075mm, 0.1mm. 
ID: shows the current rank’s ID. 
Depth: the current rank’s depth, value’s rang is from 0 to 1mm. 
Auto gradient interpolation: software computes every rank’s depth according interpolation. 
Default: generate the every rank’s depth on base of the largest depth 1mm and the largest rank number, the 

increase depth by one rank is the quotient of 1mm divides the largest rank number. 
Modify a depth by self: choose the rank in the left list to modify, the rank number will show on right, modify the 

depth, and click another rank, then the depth is modified succeed. 

2.6.8 Process Steps 

Process steps: 
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1. Open a graph file to process. 
2. The graph shows in the view, click mouse right button in the graph to add mission, likes the Figure 2-35 shows: 

 

 
Figure 2-35 Add Task 

 
Full screen, ruler and aid line are some assistant option to graph display. 
Among current layer to current machine, all layers to current machine, current layer to specified machine, all 

layers to specified machine, current layer to all machines and all layers to all machines, choose one to meet the real 
require, click it and pop a mission manage dialog box.Connect to Current Machine or Cancel Connect. 

Choose the Task Manage option in Machine menu, or click  on Tool bar, a mission manage dialog will pop 
if add a new mission successfully. 
3. Set parameters in mission manage dialog box (see mission setting and parameters setting). 
4. Choose Start in Machine menu or click  button on Tool bar or click  in mission dialog box to start the 

work. 
5. If necessary, click pause, continue, stop and stop quickly. 
 
 
 
 
 
Notice: 
1. First use this software, or use a new machine, must add the new machine and set the parameters correct. 
2. Before processing, make sure the machine link with computer, and everything is well. 
3. When the work is start, can’t move the laser head by the key panel. 
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Chapter3  ANC5150 Controller 

3.1 Overview 

ANC5150 controller is the main controller of ANC5150 laser numerical control system. Its functions are 
Ethernet communcation, fieldbus and high-speed vector motion control. 

Figure3-1 shows the outline of ANC5150 controller: 

 
Figure3-1 ANC5150 Controller 

3.2 Operating Environment 

Suggests power: 
MEAN WELL: 12V1A/5V4A DC Switching Power Supply. 
MEAN WELL: 48V/7.3A DC Switching Power Supply. 
Supports laser power supply of 5V interface. 
220V AC power supplys power for the control system after power filtering module. 
AHD401, AHD80X or other motor drivers affirmed. 
There are no special requests about connection between control system and laser power supply. Try to use the 

powers we suggested and avoid halt, restart and out of step. 
In low speed machines, stepping motor can be supplyed by 24V DC switching power supply. 

3.3 Instructions 

ANP4149 is the special control panel of the numerical control laser system. It can fix on machines or operate 
manually. It has functions of LCD Chinese denotion and keyboard input. The maximal operation distance is up to 
40m. 

Please use standard cables of control system possibly. 
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Chapter4  ANP4149 Hand Panel 

4.1 Outline 

Figure4-1 shows the outline of ANP4149 hand panel: 

 
Figure4-1 ANP4149 Hand Panel 

 

4.2 Keyboard Function Descriptions 

ANP4149 keyboard function descriptions are showed table4-1: 
 

Operation Key Main Functions 

菜 单

 

click, enter previous menu; double click, enter main operation interface 
to operate parameters and states 

启动
关闭

 
start sequence, close sequence, clear errors 

 

motor moving along Y positive orientation, data value largen, arrow 
moving upwards 

 

motor moving along Y negative orientation, data value minish, arrow 
moving downwards 

取消  

motor moving along X positive orientation, return last operation or 
interface 

确定  

motor moving along X negative orientation, switch states on and off, 
cursor moving right, confirm operation 

暂停
继续

 
pause (continue) machine running 
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手 动
出 光

 
manual lasing 

急 停

 
machine stop rapidly 

 
Table4-1 Function Descriptions 
Note: 

Every button on the keyboard has a corresponding LED above it. Push one button and the corresponding LED 
will lighten 0.5S. 
“MENU”: 

Click, enter previous menu; double click, enter main operation interface to operate parameters and states. 
“ON/OFF”: 

Normally (no communication error), push “ON/OFF” button then it send control instructions to drive board and 
turn on or off an equipment every second until all peripheral equipments on or off. At the same time, LCD according 
to the sequence of on or off displays statement of on or off non-interlace. This buttom operates startup and close 
operations and these two operations are operated in turn. The startup sequence is that: water pump – gas pump – air 
refresh – laser power – laser high-voltage; the close sequence is that: laser high-voltage – laser power –water pump – 
gas pump – air refresh. 

If there are errors, the buzzer will beep. Push this button and the error will be cleared. 

“ ”, “ ”, “ ”, “ ” 

On the main interface these four buttons control direction of light head moving. Here, “ ”, “ ”, “ ”, 

“ ” mean four direction key of “up”, “down”, “left” and “right”. 
“Pause/Continue”: 

Push “Pause/Continue” when machine is executing a task. This action pauses the current operation and 
synchronously corresponding LED lighten. Only push this button again the machine can resume the current operation. 
Corresponding LED is off. 
“Manual Lasing”: 

When laser power and laser high-voltage are on, push “manual lasing” button and laser emits light rays until 
loosen the button. 
“Stop”: 

Anytime, push “stop” button, close all equipments and the machine stop at the current position. If the machine 
needs to continue running after push “stop” button, following operations should be completed: push “ON” to clear 
errors first, then push “Pause/Continue” button to reset the machine, and it can continue working. In addition, at 
anytime, enter previous menu and push “system restart” function; the system will restart and all parameters return 
initial states, so it can continue working. 

After push “stop” button, corresponding leds of “Pause/Continue” and “stop” lighten. 

4.3 Menu Interface and Functions 

Click “MENU” and enter previous menu. The interface shows as below:  

 开闭激光
 机器复位
 系统重启
 系统信息

 
Function Descriptions:  
Laser on/off: When laser power is on, switch laser emission status if choosing this function. 
Machine Reset: Machine reset to origin 
System Restart: Control system restart. 
System information: Displays control system name and company name. 

4.4 Main Interface Operations 

Just when system power on, LCD screen displays system information and at the same time machine reset. The 
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screen displays the main interface after reset. The sequence of screen display shows as below:  

   

数控激光雕刻
切割控制系统
2004@时代自动化

 X   :   0.000 mm
 Y   :   0.000 mm
 Vxy :    0.00mm/s
 电流:        0%

1秒钟后

 
On the main interface, parameters and states those can be setted and displayed include as below: X, Y axis 

coordinates, machine working speed Vxy, laser current strength, states on or off of motor, offline, gas pump, air 
refresh, water pump, laser power, laser high-voltage. 

Users can set some parameters and states according use. The sequence of operation is following: firstly, double 

click “MENU” key, when main interface as above figure displays scroll dieblock  and or . It suggests user to 

select the parameter to set by  and . The selected parameter display is inverse (shadow). The interface 
displays as follow this time:  

 X   :   0.000 mm
 Y   :   0.000 mm
 Vxy :    0.00mm/s
 电流:        0%

 

Push , enter the operation of parameter or state shadowed.  
1. Working speed Vxy: 
  This parameter is only for display. It displays the real time speed as working; unit is mm/s. 
2. X Y axes coordinate X Y: 

These parameters display machine real-time position on X and Y axis. Unit is mm. When push  to set these 
two parameters, cursor will blink on the highest bit of value. Shows as follows 

 

Increase or decrease the value by pushing  and  this time.  increases value and  decreases 
value.Summand or minuend is the significance of current cursor position.Machine moves to the position of current 
calculated. If the value of add or subtract is less than 0, the result is considered 0. If the value is greater than machine 

maximal size, the result is considered the maximum. Push , move the position of cursor. Summand and minuend 
are decreasing followed and minimum value is down to 0.01mm. It can realize precise location on X and Y axis.  
3. Laser current strength: 

This parameter is the value of laser current strength.Push  to set this parameter. Complete add or subtract 

the strength of laser current using  or . Push  to return higher level interface. The range of current 
strength is 0~100%. 

Operation interface is following: 

Push , and current is increased. 
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4. Peripheral equipments states control: 
Peripheral equipments include motor, offline, gas pump, air refresh, water pump, laser power, laser high-voltage. 

The method to switch these states is pushing  directly to switch the shadow line according equipment. 

4.5 Normal Operation 

PWR LED: light. This means the system nomally power on. 
TXD LED: blink. This means that the panel is transfering information to ANC5150 and transfer is normal. 
RXD LED: light. This means that the panel is correctly receiving information from ANC5150. 
ERR LED: light. This means that the panel has received an error message or the system is wrong, such as exceed 

the range of maximal size, push “stop”, communcation halt. When the system is wrong, buzzer gives an alarm. In 
addation, ERR LED is light when machine restart but the buzzer doesn’t give an alarm. 

4.6 Alarm 

When the system is wrong, the panel will give alarm information. ERR LED is light at this time and the buzzer 
gives an alarm. Users should push “stop” key first, then push “ON/OFF” to clear the error; push “pause/continue” to 
reset machine lastly. The machine continue working after these operations. In addition, enter previous menu and push 
“system restart” function; the system will restart and all parameters return initial states, so it can continue working. 

Note: If the light head has stroken the position of proximity switch, it can’t clear the error that push “stop” and 
then push “ON/OFF”. Because when the light head bumps proximity switch, the error message will be send all along. 
At this time, it needs to move the light head away from the proximity switch, then push “ON/OFF” to clear the error. 
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Chapter5  ANC5150 Technical Specification 

5.1 System Connection 

 See also ANC5150 connection figure in chapter1. 

5.2 Size Specification 

ANC5150: 223mm × 146mm × 27mm 
ANP4149: 119.5mm × 71mm ×21mm 
ANP4149 location holes: 
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Chapter6  Instance 

In this chapter, all the instances are carried on in following condition: has added the machine and set the 
parameters correctly. How to add a new machine and set machine’s step distance correctly, please check the 
paragraph 2.5.1 and 2.5.2 in chapter 2, this step must be done when add a new machine, since then, it needn’t to set 
again except changing the machine or system. Because every machine’s capability and every laser power intensity is 
different, all the parameters in this chapter isn’t absolute correct, but they are could be as a reference and meet 
requires mostly, if they are not proper, please adjust them on this base. 

6.1 Cut Organic Glass Simply 

Instance’s task: cut the graph by outline, needn’t to set the array, the material is organic glass. The steps are 
following: 
1. Make sure the connection is correct, turn on the power, run the programme AgeMotion6 on the computer’s 

desktop, choose the correct machine, click  button on the Tool bar to link the computer to the machine, it may 
be unsuccessful when the network is busy, please try again (how to set and check the network, see the 
information in chapter 10). 

2. Click  button on Tool bar, a machine control dialog box pop, press the Mot. button to run machine, click the 
direction buttons to test the machine is running well or not first. If the machine runs well, move the laser head to 
the start position. Input the start point to X Set and Y Set edit control box, click the Set button on right, the laser 
head will move to the point defined. ANP4149 hand-panel is used to control the machine and appoint the position 
also. 

3. Press the Wat. , Ref , Gas pump, Las.and LHV.buttons, click the Men.button to check the laser power is running 
well or not. 

4. Choose the Open option in File menu, or click  button on Tool bar to open a file to process, in this instance, 
open the file “兰花草 2.plt”. 

5. Click the mouse right button in the view, choose the current layer to current machine option in the pop menu to 
add a new mission, if the graph file has many layers, please choose the all layers to current machine option to add 
all the missions. 

6. Set the parameters in the mission manage dialog box. Choose the cutting in the working mode combo box, 
choose normal cut in the mission’s parameters configure combo box, the software will set all the parameters 
automatically, likes the Figure 6-1 shows: 
 

 
Figure 6-1 Set Parameters 1 

 
7. If necessary, set the optimization. When set the optimization, please see contents of paragraph 2.6.6 in chapter 2. 
8. Set the first piece area as Figure 6-2 shows: 
 

 
Figure 6-2 Set First Task Area 

Please cancel the check of width, height and width-height scale first before changing the X-coordinate scale and 
Y-coordinate scale. The orientation style had better be laser head, then the machine will start at the point of 
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current laser head at. Other parameters are default. Final dialog likes the Figure 6-3 shows: 
 

 
Figure 6-3 Set Task Parameters 

 
9. Click  button, two dialogs will pop, one is task team sure dialog (see Figure 6-4), the other is task sure dialog 

(see Figure 6-5), click contine button in all of them to contine the work: 
 

  
Figure 6-4 Task Team Sure     Figure6-5 Task Sure 

10. Start processing, machine’s laser head will return the start point when the task is finished. If there is no mission, 
please click  button to disconnect the computer with machine. 
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6.2 Cut Organic Glass Complex 1 

Instance’s task: cut the graph by outline, need to set the array, contains mission’s array setting and mission 
group’s array setting, the material is organic. The steps are following: 
1. Make sure the connection is correct, trun on the power, run the programme AgeMotion6 on the computer’s 

desktop, choose the correct machine, click  button on the Tool bar to link the computer to the machine, it may 
be unsuccessful when the network is busy, please try it again (how to set and check the network, see the 
information in chapter 10). 

2. Click  button on Tool bar, a machine control dialog box pop, press the Mot. button to run machine, click the 
direction buttons to test the machine is running well or not first. If the machine runs well, move the laser head to 
the start position. Input the start point to X Set and Y Set edit control box, click the Set button on right, the laser 
head will move to the point defined. ANP4149 hand-panel is used to control the machine and appoint the position 
also. 

3. Press the Wat. , Ref , Gas pump, Las.and LHV.buttons, click the Men.button to check the laser power is running 
well or not. 

4. Choose the Open option in File menu, or click  button on Tool bar to open a file to process, in this instance, 
open the file “兰花草 2.plt”. 

5. Click the mouse right button in the view, choose the current layer to current machine option in the pop menu to 
add a new mission, if the graph file has many layers, please choose the all layers to current machine option to add 
all the missions. 

6. Set the parameters in the mission manage dialog box. Choose the cutting in the working mode combo box, 
choose normal cut in the mission’s parameters configure combo box, the software will set all the parameters 
automatically, likes the Figure 6-6 shows: 

 

 
Figure 6-6 Set Parameters 2 

 
7. If necessary, set the optimization. When set the optimization, please see contents of paragraph 2.6.6. 
8. Set the first piece area as Figure 6-7 shows, Please cancel the check of width, height and width-height scale first 

before changing the X-coordinate scale and Y-coordinate scale. The orientation style had better be laser head, 
then the machine will start at the point of current laser head at. 

 

 
Figure 6-7 Set First Task Area 

 
Set mission array, parameters are set as Figure 6-8 shows. Name is the layer where the mission is. Effectivity 
means that this task is effective, if it isn’t checked, the task is ineffective. Count is the count will be produced, it 
is no large than product of X-coordinate array and Y-coordinate array. Check the affirm space of a whole page 
option, a affirm dialog box will pop before processing, must click the continue button to go on. X coordinate 
array means the mission count in X coordinate direction. Y coordinate array means the mission count in Y 
coordinate direction. X array excursion means the space between two missions in X coordinate direction. Y 
array excursion means space between two missions in Y coordinate direction. 

 



 AgeMotion Datasheet 
 

 Hangzhou AutomaticAge Co., Ltd.  Http://www.AgeMotion.com/ 34 

 
Figure 6-8 Set Task Array 

 
9. Set the mission group, the parameters as Figure 6-9 shows: 
 

 
Figure 6-9 Set Task Group 

 
Mission group array setting is to several missions (include one mission), in this instance, setting the mission 
group is on the base of mission array setting. According to the step 8, it takes the mission array as a whole, then 
set the mission group array as 2 by 2, the product count is 3 in this mission group, means it produce 3 wholes. 
Finally, the parameters in mission dialog like fiure 6-10 shows: 
 

 
Figure 6-10 Set Task Parameters 

10. Click  button, two dialogs will pop, one is affirm mission group dialog (see Figure 6-4), the other is affirm 
mission dialog (see Figure 6-5), click contine button in all of them to contine the work. 

11. In this instance, a affirm dialog will pop after finished each whole, the task will not go on until clicking the 
continue button. Adjust the position of the material on this moment, but can’t move the laser head position. 
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12. Machine’s laser head will return the start point when the task is finished. If there is no mission, please click  
button to disconnect the computer with machine. 

6.3 Cut Organic Glass Complex 2 

Instance’s task: cut the graph by outline, and cut the figure of the whole image. Includes optimization in gradient 
and optimization in path, the material is organic. The steps are following: 
1. Make sure the connection is correct, trun on the power, run the programme AgeMotion6 on the computer’s 

desktop, choose the correct machine, click  button on the Tool bar to link the computer to the machine, it may 
be unsuccessful when the network is busy, please try it again (how to set and check the network, see the 
information in chapter 10). 

2. Click  button on Tool bar, a machine control dialog box pop, press the Mot. button to run machine, click the 
direction buttons to test the machine is running well or not first. If the machine runs well, move the laser head to 
the start position. Input the start point to X Set and Y Set edit control box, click the Set button on right, the laser 
head will move to the point defined. ANP4149 hand-panel is used to control the machine and appoint the position 
also. 

3. Press the Wat. , Ref , Gas pump, Las.and LHV.buttons, click the Men.button to check the laser power is running 
well or not. 

4. Choose the Open option in File menu, or click  button on Tool bar to open a file to process, in this instance, 
open the file “Test0000.plt”. 

5. Click the mouse right button in the view, choose the current layer to current machine option in the pop menu to 
add a new mission, if the graph file has many layers, please choose the all layers to current machine option to add 
all the missions. 

6. Set the parameters in the mission manage dialog box. Choose the cutting and cutting the frame in working mode 
combo box, choose normal cut in the mission’s parameters configure combo box, the software will set all the 
parameters automatically, likes the Figure 6-11 shows: 

 

 
Figure 6-11 Set Parameters 3 

 
7. Optimize the gradient and the path: click the Optimize button, a optimization setting dialog box pop, likes the 

Figure 6-12 shows: 
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Figure 6-12 Set Optimize 

 
Check the optimization for gradient to make machine cut inside first then the outside. Check the first step 
optimization for path, click the Equilibria button, the parameters will be configured automatically. 

8. The parameters after setting the first piece area likes the Figure 6-13 shows: 
 

 
Figure 6-13 Set First Task Area 

 
9. Click  button, two dialogs will pop, one is task team sure dialog (see Figure 6-14), the other is task sure 

dialog (see Figure 6-15), click contine button in all of them to contine the work. 
 

  
Figure 6-14 Task Team Sure      Figure 6-15 Task Sure 

 
10. Start processing, machine’s laser head will return the start point when the task is finished. If there is no mission, 

please click  button to disconnect the computer with machine. 
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6.4 Cut Paper 

Instance’s task: cut the images out of the paper, so it needs to set the optimization for gradient. The steps are 
following: 
1. Make sure the connection is correct, trun on the power, run the programme AgeMotion6 on the computer’s 

desktop, choose the correct machine, click  button on the Tool bar to link the computer to the machine, it may 
be unsuccessful when the network is busy, please try it again (how to set and check the network, see the 
information in chapter 10). 

2. Click  button on Tool bar, a machine control dialog box pop, press the Mot. button to run machine, click the 
direction buttons to test the machine is running well or not first. If the machine runs well, move the laser head to 
the start position. Input the start point to X Set and Y Set edit control box, click the Set button on right, the laser 
head will move to the point defined. ANP4149 hand-panel is used to control the machine and appoint the position 
also. 

3. Press the Wat. , Ref , Gas pump, Las.and LHV.buttons, click the Men.button to check the laser power is running 
well or not. 

4. Choose the Open option in File menu, or click  button on Tool bar to open a file to process, in this instance, 
open the file “Test0000.plt”. 

5. Click the mouse right button in the view, choose the current layer to current machine option in the pop menu to 
add a new mission (see Figure 6-16), if the graph file has many layers, please choose the all layers to current 
machine option to add all the missions. 

 

 
Figure 6-16 Add Task 

 
6. Set the parameters in the mission manage dialog box. Choose the cutting in working mode combo box, choose 

cut paper in the mission’s parameters configure combo box, the software will set all the parameters automatically, 
likes the Figure 6-17 shows: 
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Figure 6-17 set parameters 4 

 
7. Click the Optimize button to optimize the gradient and the path, likes the Figure 6-18 shows: 
 

 
Figure 6-18 set optimization 

 
Check the optimization for gradient to make machine cut inside first then the outside. Check the first step 
optimization for path, click the Equilibria button, the parameters will be configured automatically. 

8. The parameters after setting the first piece area likes the Figure 6-19 shows: 
 

 
Figure 6-19 Set First Task Area 

 
Please cancel the check of width, height and width-height scale first before changing the X-coordinate scale and 
Y-coordinate scale. The orientation style had better be laser head, then the machine will start at the point of 
current laser head at. 

9. Click  button, two dialogs will pop, one is task team sure dialog (see Figure 6-20), the other is task sure 
dialog (see Figure 6-21), click contine button in all of them to contine the work. 
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Figure 6-20 Task Team Sure      Figure 6-21 Task Sure 

 
10. Start processing, machine’s laser head will return the start point when the task is finished. If there is no mission, 

please click  button to disconnect the computer with machine. 

6.5 Sculpture Rubber 

Instance’s task: sculpture images on the rubber, contains setting the slope and processing. The steps are 
following: 
1. Make sure the connection is correct, trun on the power, run the programme AgeMotion6 on the computer’s 

desktop, choose the correct machine, click  button on the Tool bar to link the computer to the machine, it may 
be unsuccessful when the network is busy, please try it again (how to set and check the network, see the 
information in chapter 10). 

2. Click  button on Tool bar, a machine control dialog box pop, press the Mot. button to run machine, click the 
direction buttons to test the machine is running well or not first. If the machine runs well, move the laser head to 
the start position. Input the start point to X Set and Y Set edit control box, click the Set button on right, the laser 
head will move to the point defined. ANP4149 hand-panel is used to control the machine and appoint the position 
also. 

3. Press the Wat. , Ref , Gas pump, Las.and LHV.buttons, click the Men.button to check the laser power is running 
well or not. 

4. Choose the Open option in File menu, or click  button on Tool bar to open a file to process, in this instance, 
open the file “永遇乐.plt”. 

5. Click the mouse right button in the view, choose the current layer to current machine option in the pop menu to 
add a new mission (see Figure 6-22), if the graph file has many layers, please choose the all layers to current 
machine option to add all the missions. 
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Figure 6-22 Add Task 

 
6. Set the parameters in the mission manage dialog box. Choose the Sculpturing the slope in working mode combo 

box, choose normal sculpture in the mission’s parameters configure combo box, the software will set all the 
parameters automatically, likes the Figure 6-23 shows: 

 

 
Figure 6-23 Set Parameters 5 

 
In this Sculpturing instance, needn’t to set the optimizations, don’t check the positive Sculpturing. 

7. Like the Figure 6-24 shows to set the parameters for Sculpturing slope. The rank number is 21, the rank width is 
0.025 mm. Set the 0 rank depth as 0.0, set the last rank depth as 1.0, click the auto insert values button, the other 
values will generate automatically. Click OK and exit the dialog. 
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Figure 6-24 Set Slope 

 
8. The parameters after setting the first task area likes the Figure 6-25 shows: 
 

 
Figure 6-25 Set First Task Area 

 
9. Click  button, two dialogs will pop, one is affirm mission group dialog (see Figure 6-20), the other is affirm 

mission dialog (see Figure 6-21), click contine button in all of them to contine the work. 
10. Start processing, machine’s laser head will return the start point when the task is finished. If there is no mission, 

please click  button to disconnect the computer with machine. 

6.6 Sculpture Backlight Line 

 The software supports the mode of sculpture backlight line. This function is convenient for user to process 
backligt line. Instance’s task: Sculpture backlight line, including setting backlight line. The steps are following: 
1. Make sure the connection is correct, trun on the power, run the programme AgeMotion6 on the computer’s 

desktop, choose the correct machine, click  button on the Tool bar to link the computer to the machine, it may 
be unsuccessful when the network is busy, please try it again (how to set and check the network, see the 
information in chapter 10). 

2. Click  button on Tool bar, a machine control dialog box pop, press the Mot. button to run machine, click the 
direction buttons to test the machine is running well or not first. If the machine runs well, move the laser head to 
the start position. Input the start point to X Set and Y Set edit control box, click the Set button on right, the laser 
head will move to the point defined. ANP4149 hand-panel is used to control the machine and appoint the position 
also. 

3. Press the Wat. , Ref , Gas pump, Las.and LHV.buttons, click the Men.button to check the laser power is running 
well or not. 

4. Choose the Open option in File menu, or click  button on Tool bar to open a file to process, in this instance, 
open the file “Test0000.plt”. 

5. Move the cursor on the graph outline processing, and click to choose the graph, likes Figure 6-26 choose the 
circle. Click Fill option in Draw menu, like Figure 6-27. At this time, Fill Backlight is active, click it and pop the 
Fill Backlight property page(Figure 6-28). The user can adjust fill format of backlight. Fill area is divided 3 areas 
and can set property for every area alone. 
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Figure 6-26 Select Graph 

 

 
Figure 6-27 select Fill Backlight 

 



AgeMotion Datasheet 
 

Hangzhou AutomaticAge Co., Ltd.  Http://www.AgeMotion.com/ 43

 
Figure 6-28 Fill Backlight Dialog 

 
Property of Fill Area 1 (Figure 6-29) 

 
Figure 6-29 Fill Area 1 

 
Width: the width of this area to fill. Default is the whole width of graph. It doesn’t need to alter usually. 
Height: the height of this area to fill. Default is integral of one-third of whole graph. User can alter it according 
requirement And if alter the line interval, the height will change accordingly. 
New Layer: if select it, fill lines are in new layer and the layer name is “Fill Area 1”. If not select it, the fill lines are 
filled in the old layer. 
LineIntS: start line interval. The interval between the first line and second line in this fill area. 
LineIntE: end line interval. The interval between the last line and the previous line in this fill area. LineIntS and 
LineInsE decide the LineIntI and Line Cnt of this area. If LineIntS is not equal to LineIntE, the software will compute 
LineIntI and Line Cnt according to not greater than the integral of this area height, like Figure 6-30. After alter the 
line interval, click Apply and the result display. 
LineIntI: line interval increment. The increment is between one line interval and the latter line interval. It can be 
negative and the software compute it. 
 

 
Figure 6-30 Fill Area 1 
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DotPrdS: start dot interval. The interval between the first dot and the second dot. It includes the first dot length and 
the interspace between the first dot and the second. It is the sum of DotIntS and start dot interspace.  
DotLthS: start dot length. 
DotIntS: interspace between the first dot and the second dot. 
DotPrdE: end dot interval. The interval between the last dot and the edge of graph, including the end dot length. 
DotLthE: the end dot fill length. 
DotIntE: interspace between the end dot and the edge of graph. 
DotPrdI: increment of dot interval. This is the increment of the dot interval and the later dot interval. It can be 
negative and the software computes it automatically. 
DotLthI: dot length increment. The increment is of one dot according to the previous dot. It can be negative and the 
software computes it automatically. 
DotIntI: the dot interspace increment. The increment is of one dot interspace according to the previous dot interspace. 
It can be negative and the software computes it automatically. 
Color: the color of fill backlight if select new layer. Click the color block and pop the select color page (see Figure 
6-31). Click OK after choose the color, then the color of new layer is red as the figure shows. If doesn’t select New 
Layer, select color is invalid. 
 

 
Figure 6-31 Select Color 

 
Property of Fill Area 2 (Figure 6-32) 
The usages of the items in Fill Area 2 are the same with them in Fill Area 1 except underside items. 
New Layer: if select it, fill lines are in new layer and the layer name is “Fill Area 2”. If not select it, the fill lines are 
filled in the old layer. 
Fill Last: If select, LineIntS, DotIntS, DotLthS and DotIntS of this Area are the same with LineIntE, DotIntE, 
DotLthE and DotIntE of Fill Area 1 respectively. If not select, LineIntS, DotIntS, DotLthS and DotIntS of this Area 
define by user. 
 

 
Figure 6-32 Fill Area 2 

 
Property of Fill Area 3 (Figure 6-33) 
The usages of the items in Fill Area 3 are the same with them in Fill Area 3 except underside items. 
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New Layer: if select it, fill lines are in new layer and the layer name is “Fill Area 3”. If not select it, the fill lines are 
filled in the old layer. 
Fill Last: If select, LineIntS, DotIntS, DotLthS and DotIntS of this Area are the same with LineIntE, DotIntE, 
DotLthE and DotIntE of Fill Area 2 respectively. If not select, LineIntS, DotIntS, DotLthS and DotIntS of this Area 
define by user. 
 

 
Figure 6-33 Fill Area 3 

 
Use the setting as Figure 6-28, the result of fill is Figure 6-34 show. At this time, there appears “Fill Area 1” layer 
(Figure 6-35 show). 
 

 
Figure 6-34 Fill backlight Result 
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Figure 6-35 Layer Manage 

 
6. Set the Fill Area 1 as the current layer. Such as Figure 6-35 show select Fill Area 1, or select it in layer manage 

list. Click the mouse right button in the view, choose the current layer to current machine option in the pop menu 
to add a new task (see Figure 6-36). 

 

 
Figure 6-36 Add Task 

 
7. Set the parameters in the mission manage dialog box. Choose the Sculpture Backlight Line work mode combo box, 
choose Sculpture Backlight Line in the work parameters configure combo box, the software will set all the 
parameters automatically, likes the Figure 6-37 shows: 
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Figure 6-37 Task Dialog 

 
9. Click  button, two dialogs will pop, one is affirm mission group dialog (see Figure 6-20), the other is affirm 

mission dialog (see Figure 6-21), click contine button in all of them to contine the work. The task sculpture the 
backlight lines only not sculpture the outline. 

10. Start processing, machine’s laser head will return the start point when the task is finished. If there is no mission, 
please click  button to disconnect the computer with machine. 

6.7 Combine Files 

The software’s greatest property is combining several graph files to one graph file, in this instance, the task is 
combining two plt type files to a dxf type file, and steps are following: 
1. Run the programme AgeMotion6, choose the Open option in the File menu, or click  button on the Tool bar 

to open the first plt file to be combined, in this instance, open the file “兰花草 1.plt”. 
2. Choose the Import options in the File menu (see Figure 6-38), import the second plt file “兰花草 2.plt” to 

combine with the first file, the complex likes the Figure 6-39 shows: 
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Figure 6-38 Import a File 

 

 
Figure 6-39 Complex 
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3. Save file: choose the Save as option in the File menu, decide the path where the complex is saved, save the result 
file. 

4. Open the dxf file that saved previously, the image in this file is a complex that contains the images in “兰花草
1.plt” and “兰花草 2.plt”, it can instead of those files in the future. 
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Chapter7  Troubleshooting 

1. Normally, the control system appears the depth of laser processed uneven: 
Check the laser path if deflected, the mirror of laser whether clean, air refresh and gas pump whether working 
normally, drive system whether loose. 

2. Normally, the control system appears cutting unsmooth: 
Check the laser path if loose, the motor if has abnormal sound and whether the drive system loose. 

3. Normally, the machine appears cutting depth different: 
Check whether the rate is too fast or intensity of laser is so weakly. 

4. Normally, the machine appears pause and close the laser: 
Check whether cooling water is working normally, output of switch for turn off water is right. Suggest that repair 
the waterway after shut off machine 5 minutes. 

5. The position of matchine has lighted limit switch but the machine is moving in the same orientation: 
Check the limit switch and its connetion. 

6. Error occur in motion orientation on X/Y axis: 
Check the connection of singal DIR on the motor driver, if connection is right then exchange one phase 
connection of phases A/B. 

7. Motion equipments of light head are out of control and make a screech: 
The motor was out of step, please push the “stop” immediately and the other steps refer the chapter of keyboard. 
The reason of lose control of motion are as follows: speed is too fast, acceleration is too fast, drive current is too 
little, instantaneous invertion phase move when keyboard operating, drive system is loose, resistance on guide 
rail is too strong. 

8. Motion equipments of light head are wobbling at intact place: 
Motor is lacking phase, please check the connection of motor. 

9. Motor appears that motion speed is not normal: 
Check the setting of motor driver and its connection. 

10. AgeMotion6 cannot connect with hardwares: 
Check the devices communicated with computer and theirs configuration, communication line, controller and 
serial number and software password. 

11. The speed of straight cutting is faster than curve cutting: 
The speed of curve cutting can achieve is limited with its shape, machining precision, working acceleration and 
working speed, while the limit for straight cutting is less oppositely. So straight cutting is faster than curve 
working. But a very short line must be slower than a circular arc with long radius, so the relationship between 
straight and curve insicion is not absolute. This condition is normal. Unless alter the setting of working 
parameters, the machining speed of a certain line impossibly exceed the fixed limit speed. In order to maintain 
the consistency of the two statuses speed that we can do is only to reduce the working speed on the condition that 
doesn’t alter another parameters. But we don’t suggest this method for it will reduce working efficiency. The 
reason occurs this condition is that curve cutting can’t exceed a certion fixed speed but straight cutting can 
achieve a higher speed. 
For example, when the motion control system wheel angle greater than or equal 90, the wheel speed must be 0. If 
the system speed maintain invariable, then the entire machining speed should be 0. 

12. The laser can’t turn on: 
Check the waterway and whether the water switch is normally working or not. 

13. The voice of motor is too high: 
The rated speed or magnetic core frequency of motor is too slow. Please use better stepping motor. A worse 
stepping motor is worse on linearization and response time. These cause that motion in electromagnetic vector 
space unsmooth and dynamic moment small, thereby amplitude greater. 

14. The size of file export has random error or tiny error: 
The random error is caused by the limitations on mechanical or light path and the disposal to these errors should 
deal with these limitiations. The causations for fixed such as light leaning and tiny error caused by the drive ratio 
of drive system can be settled by adjust minitrim amplification coefficient or stepping distance. 

15. If the machine bursts into the condition that cannot connect with computer normally and has never occurred this 
similar status previously. It is possible that your accredited password has exceeded the time limit. Please consult 
with the supplier. 

 
16. Once working the driver is broken 
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 Check the voltage of Switching Power Supply is steady or not. If it is not steady, the instantaneous current of 
driver will exceed and make the driver broken. Please use the Switching Power Supply we suggest.
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Chapter8  Notice 

1. In order to install, current connect, operate and maintain correctly, please read this user’s manual carefully and 
understand all contents. 

2. The manual should be keeped by ultimate user. 
3. The manual should be maintained until the system rejected. 
4. The technical specification will be likely to modify and forgive us no notify. 
5. Please store this manual with the system appropriately after use so that you can use it at any moment. 
6. Please don’t close with combustible material whenever installation or use. 
7. Please fetch and put gently. 
8. Dust and metal dross cannot drop into the controller, otherwise will occur short circuit. 
9. Please don’t use or operate the system when it has been destroyed or some equipments have bugs. 
10. Power must be down when connect system connections. 
11. Suggest turn off main power 20 minutes before connect high-voltage connections. This time is different for 

relative laser power. 
12. Please keep a proper distance as the laser high-voltage operating. The laser high-voltage is 15KV~20KV 

generally. We suggest keeping 20cm distance. If the weather is moist the distance should be farther. Assure that 
the laser power connect with ground reliably. 

13. Please check whether waterway is in good condition and water quality is clean and periodically check the water 
switch whether works normally or not. 

14. When the machine is processing the task, don’t alter the parameters of operation optionally. 
15. Avoid using this system when thunder storm. 
16. For the control system will emanate heat, keep the entironment of operation ventilative for heat of emission. 
17. The control system should not be affected with damp and don’t operate when hands are wettest. 
18. If detect the control system is abnormal, please push “stop” button to stop the system and turn off the power. 
19. The terminals of control system are electriferous even in stop state when the system turns on power, so you 

cann’t touch them. 
20. Please don’t use turn on and off the main power to run and stop the control system. 
21. The temperature of controller and drivers are high sometime, so don’t touch them. 
22. Please confirm the running capabilities of stepping motors and mechanical equipments when alter settings. 
23. Maintenance, check and components replacing should be responsible by the appointed professional. (Please take 

down metallic material such as watch and ring and use insulating tools. 
24. This product should be disposed as industry disposal when rejected. 
25. Forbid rebuilding the control system. 
26. The controller and drivers should be installed vertically. Don’t install them conversely or leanly and fix them on 

firm devices using bolts. 
27. The workmen cann’t leave the working place when the system is working. 
28. Please confirm the system time of your computer is precise before install the software. Only by the condition that 

the system time is precise the software can use normally. 
29. Please don’t alter the system time optionally after install the software. 
30. Cooling water output of the laser pipe should be placed upwards. 
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Chapter9  FAQ 

Q：Whether AgeMotion6 is the update revision of AgeMotion5 or an entirely different revision and what 
difference on functions between AgeMotion6 and AgeMotion5?  
A: No, AgeMotion6 isn’t an update revision of AgeMotion5 but a entirely different revision and it is independent of 
AgeMotion5. AgeMotion6 modifys some flaws in AgeMotion5. There are not only all functions of AgeMotion5 but 
also many functions that AgeMotion5 doesn’t have. So the function of AgeMotion6 is stronger and operation is more 
convenient than AgeMotion5. 

Q：Do we should delete AgeMotion5 before install AgeMotion6? Is it harmful to the computer system and 
affected by each other when two revisions exist at the same time? 
A：You need not delete AgeMotion5 before install AgeMotion6.Because they are independent and they don’t affect 
each other as running and also not be harmful to the computer system. You can delete AgeMotion5 after install 
AgeMotion6 because AgeMotion6 has all functions of AgeMotion5.  

Q：What’s the difference between NL and NLS of AgeMotion6 and do we need install both version？ 
A：NLS is compact version. NL is complete version and also the increment revision of NLS.There is no difference on 
function between two versions. The only difference of them is that NLS is more abundant on gallery and fodder, so 
users can select and refer them. Suggest that user install NL version as install AgeMotion6 first time because it can 
afford abundant fodder reference. So you can choose the NLS version to install later; thus you can install the software 
quickly and also get abundant fodder.  

Q：Will AgeMotion6 have update revision in the future? If has, how distinguish which is newer? 
A：Yes, AgeMotion6 is serial software and we will update it in the future. You can judge the newer according to the 
version number; for example, version 6.00.10 is newer than 6.00.09.  

Q：Should we install the older version before we can install a new version? 
A：Needn’t. Though our software will be updated, this will not affect the use of users. In other words, it’s no matter 
whether you have installed an old version AgeMotion6 or not. If you have installed an old version, you can set the 
same path for setup as an old version and then the installshield wizard will finish the covered installation 
automatically; if have not, it’s more convenient and just finish the installation according to the installshield wizard.  

Q：I have installed an old version of AgeMotion6 before install a new version; do I need to delete the old 
version before install a new?  
A：It’s no effect on installation and use for a new version whether deletes the old version or not. 

Q：How do we delete an old version when we want?  
A：You can find AgeMotion6 from the start menu and select wizard of “uninstall AgeMotion6” then the system will 
uninstall the software automatically. Additionally, you can run “add/delete program” in the system control panel and 
select “change/delete”; uninstall has finished. 

Q: Why multi-layer can not align in order always? 
A: It is easy for files of dxf format which are absolute coordinate. But it is not easy for bmp and plt files of their 
relative coordinate. When export a multi-layer graph from cdr file, only use the way of import layer to align. 

Q: Why cut is not from inside to outside? 
A: You must select the Gradient in Optimize. 

Q: Why the order of cut is not as the same as design? 
A: You must not select all options in Optimize. 

Q：Why the motor moves slowly when start?  
A: The step of motor driver is too bigger than the machine’s. Reduce the step on Machine Manage page. Close the 
software and restart, then the motor move normally. 

Q: Why connection is correct, but action of the driver is not correct? 
A: Check if connect into isolation layer or not. If set into isolation layer, the connection is vain actually. 

Q: Why the action of dial switch is not correct? 
A: Check the dial switch if dial to the designated position. 
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Q: What should we do when the driver is very hot? 
A: Check the position for place drivers if avail to emit heat. And check the fan of heat dispersion if work normally. 

Q: Why the motor whistles and moves irregularly? 
A: Check the connection. The error control signal or phase lackness when motor moving will bring whistle. 

Q: Why the stepper motor is always out of step when speed up? 
A: The motor system is inertial, but the drive power of motor is limited. So when the exceptation drive power 
exceeds drive power of motor, the motor will be out of step. Design the proper and continuous curve of accelerate and 
decelerate. 

Q: Why the direction of motor move is opposition? 
A: Exchange motor coil of any one group, but not exchange two groups at the same time. 

Q: How to choose the supply voltage of AHD80X? 
A: The higher of the supply voltage the bigger of dynamic moment, and it is more proper for movation of highspeed. 
When the motor capacitance more, while the supply voltage is relative high, then the current feedback of motor will 
bring on voltage rise to overvoltage protect. In such a case, you can connect a parallel big capacitance of proof 
pressure for 100V outside the driver. The capacitance decides by the capacitance of the motor. Normally is serval 
hundreds to thousands microfarad. 

Q: If the driver will be destroyed when set AHD80X current bigger than rated current or not? 
A: The setting of driver current and the external motor capacitance are not effective on AHD80X reliability. But the 
too big current will bring to noise raise or use-life shorten. AHD40X requires setting current and motor capacitance 
matching. 

Q: What difference among four type of AHD80X? 
A: Type A/B step bandwidth is lowest.Type D is most high, most reliable and it is most simple to control. AHD801X 
fit motor of 42/56/57/(86) and AHD802X fit motor of 56/57/86/(110). 

Q: If the driver will be destroyed as undervoltage, overvoltage, short circuit, open circuit or error phase or 
not? 
A: It does not destroy the driver. But overvoltage occurs to burn the inner fuse. The several hundreds volt will destroy 
AHD80X. In such cases AHD40X will be destroyed. 

Q: Why my controller can not drive AHD80X? 
A: Check the drive current of controller is enough or not.
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Chapter10  Relative Knowledge 
10.1 Ethernet 

This manual mentions the concept of Ethernet many times; so it’s necessary to make illumination in brief for 
users’ references. 

10.1.1 Ethernet Summary 

Ethernet belongs to low layer protocol of network and generally operates on the layers of physical and data link 
of OSI. It is the most universal communication protocol standard in local area network currently. This standard 
defines cable type used in LAN and the method of processing signals. It is the most general coaxial-cable system that 
which is bus model and data rate is 10Mbps. This system is cheaper and easier installation oppositely. The cables can 
connect from one workstation to another workstation by using the BNC-T connectors on every workstation and 
complete tasks of network transmission and control. 

10.1.2 Set Ethernet 
XP operating system: Network Neiborhood  property  local connect  property  Internet protocol 

(TCP/IP)  property. Please set the TCP/IP address as 10.10.10.XX, which XX is from 2 to 254. Netmask is 
255.255.255.0; push the OK button and exit.The setting is completed. 2000/XP don’t need restart but 98 needs restart. 

10.2 Network Connections Detection 

Run the running in the system start menu by the command ping 10.10.10.xx –t to detect whether the network is 
connective or not. For example, IP address of the machine is 10.10.10.92, you entry ping 10.10.10.92 -t ; push OK 
and run. The time of ping can last one minute ; as long as one time is connective, the network communication is 
normal and the ETH indicator light TX/RX of ANC5150 will blink when running ping process. If TX/RX doesn’t 
blink, it is possible that coaxial lines trouble, A/B types fault, machine pause because of failure (it can nomally work 
after hardware reset), the fault network configuration of computer. 

10.3 Glossary 

1. Acceleration: In Physics, acceleration (abbr a) is defined as the rate of change of velocity with respect to time 
(derivative for velocity to time). It is a vector (a directional parameter).It expresses by formula 10-1 as follows: 

dt

dv
a                (Formula 10-1) 

a is acceleration vector, v is velocity vector and t is time. In international system of units, the unit of acceleration 
is m/ S2 (meter per second2 ).Acceleration is the expression for ratio of change of velocity.For example, beginning 
velocity of an object is v0 = 0 m/S, acceleration is a = 5m/ S2 . According to formula 10-2, calculate the velocity 
of it after time t = 1 S. The velocity is vt = v0 + a×t = 5 m/S. 

tavvt  0             (Formula 10-2) 

Where, vt is the velocity after time of t, v0 is original velocity, a is acceleration and t is time. 

2. DSP: Digital Signal Processing is a method of processing real world signals using mathematical techniques by 
special or usual digital signal processing chips. The advantages of DSP are fast processing speed, flexibility, 
accurate, reliablity and tininess. DSP has come into being a new technical field and an independent knowledge 
system. It is a potential domain and market. 

3. HUB: HUB is interconnecting equipment to connect multiple computers in computer network or another devices. 
It is the least cell of centralized management in network. Hub in English means center. It likes the trunk of a tree 
and it is the focal point of all branch points. HUB is shared equipment. The function of it is to magnify and 
transfer signals. It issues the all signals from a certain port to all other ports. Some hubs enhance signals before 
issue and some hubs array sequences of signal in order to synchronous data communication on all ports. 

4. Network interface card: Network interface card is also named as NIC.It is a adapter installed in computer. It 
offers connection point to network. Every NIC design is for a special network such as ethernet networks, token 
ring networks, FDDI, ARCNENT. They operate on physical layer of OSI and offer a connection point to a given 
cable, such as coaxial line, twisted-pair line and optical fiber cable. Wireless network NIC communicate with a 
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base station by antenna. 
5. Broad band: Broad Band is also named as bandwidth. It means information quenlity can be transferred in a 

certain time. It is carrying data ability in transfer channel. In digital equipments, Broad Band is expressed by bps, 
i.e. Bits Per Second. In analog equipments, Broad Band is expressed by transfer cycles per second or Hertz (Hz). 
Broad Band is import for Basic Input/Output System (BIOS). For example, fast disk storage drive will be 
blocked by a low bandwidth bus. 
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Chapter11  Support 

11.1 Service 

Thank you for purchasing our numerical control system. Our products stick labels of guarantee voucher. Don’t 
tear it up. The specifications about guarantee period and after-sale service are as follows: 
Guarantee period: 

The product guarantee period is that 36 months after purchase or 40 months after manufacture. Either period 
exceeded, the product guarantee period is considered exceeded. But if occur following conditions, the buyer should 
pay for repairment even in guarantee period: 
1. Because operate without according to the user manual, the system occurs fault. 
2. Rebuilding and repairing improperly 
3. No guarantee voucher label 
4. Using beyond standard specifications 
5. Break or destroy in traffic after purchase 
6. Earthquake, fire, windstorm, lightning strike, abnormal voltage, others visitations of Providence and conic 

disasters.  
7. Disassembling the system without permission. 
 
Service: 
1. When the using status isn’t well, check first, then read the manual and remove trouble. 
2. Please contact the distribution when appear trouble. 
3. Disposals in guarantee period: If the cause of fault is our company manufacture, we will only repair this system 

freely. If trouble causes other accidents and makes system rejected or casualties, we are only responsible for the 
guarantee and compensate of the system. 

4. Exceeded the guarantee period, we are not responsible for the product at all and the customer should pay for 
repairment. 

5. AgeMotion6, the numerical control software does’t belong to ALC numerical control system saled. AgeMotion6 
is an independent numerical control software product. Users will freely get a suit of AgeMotion6 for common 
users which supports corresponding type of ALC numerical control system when buy an ALC numerical control 
system. We guarantee that customers update AgeMotion6 freely one year after purchase. The right to interpret 
belongs to our company whether the users obtain a free update AgeMotion6 or not. Customers should not pirate 
and copy AgeMotion6. 

6. If products repair in guarantee period is no trouble in fact after our examination, customer should offer carrying 
cost and insurance.  
 
Consider that you have accepted all clauses in this manual once purchase this product. 

11.2 Contact Us 

Manufacturer : Hangzhou AutomaticAge Co., Ltd. 
Addr. : Room 212-213, Building A East, Zhejiang University Science Park,  
 No.525 Xixi Road, Hangzhou, China, Zip: 310013 
Tel : 0086-571-85022190 
Fax : 0086-571-85022590 
Web : http://www.AgeMotion.com/ 
Email : Sales@AgeMotion.com（Recommand use personnel’s email） 
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Appendix A  Anti-jamming Connection 

ANC5150 NC Laser System Anti-jamming connection as show the figure below: 

Air-break 
Switch

ANC5150

Step-motor 
Driver

ANC5150 NC Laser System
AC220V Anti-jamming Connection

AC Supply
AC220V

ETH

ACN

ACL

ETH1

ACN1

ACL1
48V

Switching 
Power Supply 

5V/12V
Switching 

Power Supply 

M

Water 
Pump

Air 
Refresh

Gas Pump

Laser Power 
fit EMC

Laser Power 
unfit EMC

Outside Relay

L1 L2

L3

L4

L5

L6

L7 L
aser P

ow
er 

C
onnection fit 

E
M

C
 

L
aser P

ow
er 

C
onnection unfit 

E
M

C

L8

Step-motor

 
 
Connection and system Specification 
1. If there is serious interfere, the control system or the motor driver will restart. ANC5150 and AHD serial 

step-motor driver will not halt. When serious interfere restart is that the software takes steps to prevent datum 
errors and process chaos. 

2. The external interfere of system is lied on the environment of electricity usage. It is uncertain. The main interfere 
sources are invert equipments, arc welding, linear power supply and power grid surge. The internal interferes is 
mainly the laser power. The laser power is invert equipment. So the laser machine tool must adopt AC220V 
anti-jamming connection to assure the system long-term and steady working. 

3. The user can disconnect the anti-jamming portion only when you are sure that the exeternal interfere is not great 
and adopt the laser power according EMC. 

4. The environment of electricity usage for main users is relatively good. But laser power supply in market are no 
any EMC certification and the invert power lack EMC portion for cost saving. So the anti-jamming measure must 
be done. L1, L2, L3 and L7/8 must connect. If the power of laser power supply is little relatively, L2 and L3 can 
not connect and use the upper simple connection. Large power or serious interfere use the nether complicated 
connection. 

5. 48V switching power supply of step-motor driver and 5V/12V switching power supply of ANC150B can not use 
the common ground and can not use a single 5V/12V/48V switching power supply yet. The switching power 
supply must use productions pass EMC certification and safety certification. ANC150B chassis connect ground. 

6. The system can mostly work stably using passed certification switch power supply and no adopt anti-jamming 
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measures. 
7. L4, L5 and L6 can not connect generally. 
8. L1 to L8 are toroidal magnetic core. But when use laser power supply inconformity EMC, we suggest to use 

suitable choke or reactor or use long-distance single power supply. 
9. The coil of toroidal magnetic core is inphase coil. 
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Appendix B  File Formats AgeMotion Support 

Filename Extension Description 

*.amf AgeMotion6 graphics file  

*.bmp Windows or OS/2 bitmap file 

*.dib device irrespective bitmap 

*.rle Run-Length coding bitmap  

*.dst Tajima embroider format file 

*.dxf 
Drawing exchange format, text representation of binary DWG format; data 
exchange file (created by AutoCAD) 

*.emf Windows enhanced metafile 

*.exif numerical camera fil, it is a mutation of JPEG 

*.gif Graphics Interchange Format 

*.ico Windows Icon 

*.jpe, *.jpeg, *.jpg, *.jfif Joint Photographic Experts Group (Created by PhotoShop) 

*.plt 
HPGL graph plotter plot file; AutoCAD plot file; Gerber symbol making 
softwar (created by CorelDRAW mainly) 

*.png portable network graphic 

*.prj AgeMotion6 project documentation 

*.tif, *.tiff Tagged Image File Format 

*.wmf Windows metafile 

*.wks AgeMotion6 environmental file  
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Appendix C  Meausrement Units 

Units in this manual, AgeMotion6 and the control system show as follow: 
1. m: meter 
2. mm: millimeter 
3. Inch: inch, 1 Inch = 25.4mm 
4. Hz: hertz 
5. DPI: dot per inch, create PLT files according 1016DPI 
6. S: second 
7. min: minute 
8. h: hour 
9. bps: bits per second 
10. BPS: Bytes per second 
11. D: degree 
12. Rad: radian, 1 Rad = 180/π D 
13. MIPS: million Instructions Per Second 
14. m/S: meters per second, unit for velocity 
15. m/ S2 : meters per square second, unit for acceleration 


